
A LAWYER’S GUIDE TO

DOCUMENT AUTOMATION 
AND BUILDING LEGAL 
DOCUMENTS IN MS WORD



LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com

TABLE OF 

CONTENTS

Introduction

I. What is a legal template?

II. The problem with manual drafting

III. Tips to building better legal documents in MS Word

IV. The value of automated legal templates

V. Types of legal documents

VI. Benefits of using automated templates

VII. Top features that make up advanced document automation

03

05

06

07

12

14

16

20



3

DOCUMENT AUTOMATION AND BUILDING LEGAL DOCUMENTS IN MS WORD

Lawyers juggle many projects every day, and drafting accounts for a big portion of that. They 
need to quickly produce clear, accurate, and consistent documents for various cases, send 
them over to clients for signature, and submit them to the court. Errors can be costly and can 
damage both reputation and credibility. If left unchecked, flaws can populate across different 
docs, costing more time to fix later. Sometimes, mistakes aren’t even detected until they are 
submitted to the client or court. 

But avoiding those mistakes can be a herculean task for firms that do this manually and work 
solo or with smaller teams.

Missing and incorrect information in documents was the top reason why courts rejected legal 
filings in 2021. And while the number has increased in recent years, it has always remained the 
main reason for document rejections. This doesn’t mean that lawyers overlook proofreading, 
or that document review isn’t a valued part of the routine. But between researching, client 
communication, billing, building up a case, and other related tasks, there just isn’t enough 
time in the day to carefully examine projects. 

The challenge of making time to proofread isn’t new to the legal industry. Since before the 
pandemic, most lawyers have struggled to dedicate time to document inspection. In one 
survey, 33% of legal professionals admitted to skipping proofreading when creating legal 
papers. The obvious alternative is getting the drafting process right the first time. Minimizing 
manual intervention and utilizing free features within Microsoft Word to build dynamic, 
flexible, and accurate templates will help lawyers get past the top challenges within drafting. 
If employed smartly, these templates will maintain the formatting, consistency, and speed 
required to move this workflow faster.

36% of filings were rejected due to incorrect or missing 
information on the document or within the overall filing.*

https://f.hubspotusercontent30.net/hubfs/470182/InfoTrack Content Syndication 2021/Top_eFiling_rejection_reasons_report_2021 (1).pdf
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In this eBook, we’ll share how lawyers can use MS word efficiently to generate legal templates 

faster. We’ll also share what automated templates are and what they do for your firm. Here’s 

what we’ll cover:

•	 What is a legal template?

•	 The problem with manual drafting

•	 Tips to building better legal documents in MS Word

•	 The value of automated legal templates

•	 Types of legal documents

•	 Benefits of using automated templates

•	 Top features that make up advanced document automation
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I. What is a legal template?

For a single case, a lawyer has to produce various records, from court filings to briefs to 
affidavits and contracts. This is where templates can come in handy. They contain consistent 
document layouts, fonts, and style elements to meet a firm’s brand standards, and matter 
criteria, as well as court regulations. They often incorporate standardized wording, which must 
be customized based on client and matter details. Simply put, they provide the framework for 
lawyers to build detailed legal papers. Because legal documents have distinctive requirements 
and formats, templates become highly beneficial to simplify and speed up the drafting process.

Traditionally, firms created these manually by entering data and copy-pasting details to populate 
projects with client and case details. However, in recent years, firms have started automating this 
part of the legal workflow to achieve greater workflow accuracy, speed, and efficiency.

86% of law firms say that cloud-based legal technology 
improves client satisfaction.   -Legal Trends Report, 2022

Automated templates drastically reduce data entry and errors resulting from repetitive typing. 
Many firms have mastered automated templates to complete routine drafting in just a few 
clicks. This fast-tracks the drafting process and allows them to onboard more clients and 
projects. While this enhances the customer experience by delivering projects faster, it also 
enables profitability and business growth initiatives with the extra time at hand.

LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com
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The traditional approach to drafting legal documents was taking a similar record, copying 

the version, and then editing it with the client and case-specific details. The cumbersome 

process opens room for lapses like typos, consuming the firm’s hours and money. Common 

drawbacks include:

While “Find and replace” is an excellent time-saver to automate text 
changes across the document, there will still be instances when it 
may not be most efficient to use, for example, in the text within a 
conditional logic section.

Depending on the case, a range of documents will need to be inserted 
into the package. Relying solely on your memory to know what to 
attach can be tricky. With document automation, you can depend on 
the software to understand what’s required within the package and 
what’s complete and ready for signature.

There is a chance you could be using an inaccurate or obsolete version 
of the legal template required by the court. Running a manual check 
to confirm its validity can be time-consuming and forgetting to do so 
can potentially result in rejection from the court. If you rely on online 
sources for your templates, there’s also the risk of downloading a 
modified or outdated version which isn’t acceptable anymore. 

Missing  
Details

Incomplete 
Package

Outdated 
or Incorrect 
Versions

II.The problem with manual drafting

LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com
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III. Tips to building better legal 
documents in MS Word

Using MS Word’s free tools efficiently is critical to legal drafting. Knowing the ins and outs of 
it will make your job much easier. Here are some Microsoft Word features that will add more 
efficiency to a lawyer’s routine:

1. Use basic text editing shortcuts

Paste
unformatted

PC + +

MAC + +

Cut

PC +

MAC + Copy

PC +

MAC +

Paste

PC +

MAC +

ctrl ctrl

ctrl ctrl shift

shift

command command

command command

Pasting unformatted text can save time 
reformatting a cluttered doc in the future or 
even keep your lists from getting crushed by 
the newcomer style.

LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com
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Paragraph

Undo

PC + +

MAC + +Redo

PC

MAC

Save

Section

PC +

MAC +

+

+

ctrl ctrl

ctrl

command command

command

option

option

PC

PC

+

+

+

+

MAC

MAC

alt

alt

Double-click: Select one word

Triple-click: Select a paragraph

Find and replace: to replace all mentions of a 
specific term in a document with another term.

2. Try Word Styles

Documents with clean, consistent formatting reflect professionalism and attention to detail. But 

giving a messy document a meticulous makeover can be a tedious and time-consuming task. 

Word’s Styles tool allows you to apply your desired formatting to the entire document quickly. 

All you have to do is determine what you want certain types of text to look like, and then, with 

one click, your document is coded in that exact style. Here are some Styles to consider:
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•	 Default Styles: Word offers default styles and 
you choose whether or not they fit your business 
requirements. For example, Headings, font size, font 
type, paragraph spacing, line spacing, etc. will be set to 
a certain setting by default and if this fits your branding, 
you can easily use them.

•	 Customized Styles: Do you want all your documents 
designed with a specific font type, size, and headings 
style? It’s simple to create styles. Simply click on the 
Styles Pane in the Styles tab, fill in your settings, create 
a name for the Style (e.g. Wills and Estate) and save. It’s 
now ready to be populated whenever you like.

•	 Adjust styles: Have an existing style (default or 
custom) and want to modify it? Right-click on it in the 
Styles column and click Modify. From here you can easily 
make changes to existing Styles.

3. Create numbered lists

Start by setting up numbering templates. You can click on the list icons in the Home tab and 

choose from the list icons. The left option manages bulleted lists, the one in the center covers 

numbering, and the option on the right is for multilevel lists. Lawyers tend to use the right 

one most often. To customize the multilevel list, click on Multilevel List, and then Define New 

Multilevel List at the bottom of the popup. The screen with new list settings will pop up.
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4. Track document changes

5. Remove sensitive metadata from documents

This feature allows you to record edits from different collaborators on a document. To turn 

on Track Changes, click on the Review tab and turn the Track Changes toggle on. If you can’t 

switch it on, go to Review, select Restrict Editing, and then click Stop Protection to enable 

tracking. Remember to turn this feature on before editing the text, and make sure your 

colleagues do the same. 

When turned on, Track Changes will mark deleted text with a strikethrough, and edits will 

show as underlined text. To change how updated text is displayed, click the Mark-up Options, 

go to Balloons and click Show All Revisions In-line. This will show all changes displayed as 

tabs. You can also hide changes from the Track Changes view by clicking Mark-up Options and 

selecting/deselecting any of the correction types (Comments, Insertions and Deletions, and 

Formatting). Keep in mind that the person receiving your edited copy will be able to see all 

your changes. In best practice, you (and any other document reviewers) should finalize edits 

and Accept or Reject changes before submitting any final version.

Avoid losing sensitive metadata by using Word’s Document Inspector functionality. This is 

information that isn’t written explicitly in the body of a doc but is still present and accessible 

through the file, for example, comments, editor’s name, links, etc. 

To see the metadata in your document, go to the File tab, click Info, and select Check for 

Issues. Then click on Inspect Document. Document Inspector will display all found metadata 

by categories. You can delete anything that you believe shouldn’t be visible by the recipient.
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6. Password-protect your documents

Enhance your attorney-client privilege by password-protecting your documents. Setting this 

up will keep information only between the intended parties, adding that extra layer of security 

and giving you peace of mind. Here’s how to password protect your documents: 

1.	Go to the File tab 

2.	Select Info

3.	Select Protect Document 

4.	Click the Encrypt with Password option

There’s almost no limit to the features and things you can do to improve template design and 

document generation. You will discover more shortcuts and tricks as you continue working 

on the platform, but we hope these tips will help you get on this path to better and more 

enjoyable work.
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IV. The value of automated  
legal templates

Preparing motions, appeals, agreements, contracts, and thousands of other legal documents 
contribute to countless hours of effort. The manual process is slow, tedious, and error-prone. 
Firms often start with a similar document from another client’s file and use a copy/edit 
process to change details to match the case. If your law firm is still using a manual document 
creation process and experiencing delays, mistakes, and other challenges, it’s time to 
consider document automation.

Automated legal templates simplify drafting by auto-populating data across sets of 
documents, so you don’t type everything out or make constant edits. Depending on the 
platform you’re using, details such as case numbers, client information, party names, etc. will 
be auto-filled by the software, saving you time and increasing your firm’s productivity. Once 
automated, legal templates are easy to customize using advanced features like conditional 
logic to adjust pronouns and align subject-verb agreements.

Automation also brings the opportunity to attract talent to your firm. Many legal 
professionals have technical skills and want to help improve access to justice. However, 
they don’t necessarily want to spend time drafting documents from scratch every time. In 
adopting these new and efficient technology solutions, there is an opportunity to make your 
firm more attractive to talent and clients.

With document automation software like Lawyaw, you can easily convert your existing MS 

Word-based documents into customizable templates and populate them with client and 

LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com
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matter details in seconds. From here, you can share them with your team for collaboration or 

directly with the client for e-signature, and then securely store the document in the cloud.

It’s important to note that automated templates do not replace humans with a robot or 

machine, but rather empower legal professionals to enhance the quality and speed of 

their day-to-day work. Lawyers who embrace change do not see automation as a threat. 

Firms using the right technology can produce high-quality work in much less time without 

experiencing frustration or fatigue. There is a massive latent demand for legal services that 

cannot be realistically met by the traditional business model.

Client satisfaction, employee performance, and 
increased revenue were the top three benefits for firms 
using cloud-based legal solutions, according to the 2022 
Legal Trends Report.

Client expectations have also gone up. As people become comfortable using technology 

for daily activities like online shopping, electronic payments, digital appointments, virtual 

meetings, etc., it makes sense to adjust your operations to accommodate those habits. Will 

your clients want to visit your office to sign papers, review document changes, and pay bills?

Let’s keep in mind the value of a healthy work-life balance too. Lawyers are often 

overworked because admin work takes up a big chunk of their day. During the pandemic, 

the lawyer billed just 2.5 hours of an 8-hour workday, signaling that many firms struggle with 

inefficiencies that take time away from billable work. If you spend less time on administrative 

tasks, you will have more time to focus on billable work, leading to a healthier work-life 

balance and reduced stress levels. The end goal of automated tools is to free up more time 

that can be invested in high-focus or business growth initiatives like networking, CLE credits, 

marketing, or even pro bono work. 
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V. Types of legal documents

Before we jump into how to produce solid documents out of legal templates, let’s take a step back 

and look at the type of documents lawyers use and the requirements from courts around them.

Typically, we have two types of documents—PDFs and DOCX. PDFs are primarily used to fill 

out court forms, and DOCX is used to prepare proprietary documents. PDFs are available on 

court websites and are free to download and use. Lawyers download these and fill them out 

with client and matter details. DOCX are editable Word documents, sometimes available on 

the court website, but mostly developed in-house or outsourced to a content publisher.

•	 36% of legal docs are  
rejected because of missing 
or incorrect information.

•	 17% of docs are in the  
wrong order.

•	 10% are rejected due to 
doc defect or illegibility.

LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com
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There are several reasons why courts reject forms or other documents—completing these 

repeatedly can be frustrating and a waste of time. That’s why it is crucial to understand the 

distinction between the two; what’s required in your jurisdiction; and when/how to use them. 

For example, PDFs can be mandatory to use in some jurisdictions versus others where they are 

optional or recommended. Understanding these details will help you complete projects faster 

and explain the process to your clients.

15



16

DOCUMENT AUTOMATION AND BUILDING LEGAL DOCUMENTS IN MS WORD

VI.Benefits of using automated templates

Saves Time

Based on 2022 legal research, lawyers work more than the typical 9-to-5 daily hours. About 

56% of lawyers work beyond 5 pm, and an alarming 11% continue working after 10 pm. 

While some legal work requires expert intervention, such as research, tasks like drafting can 

benefit from automation. Automating documents enables you to create legal documents in 

minutes, freeing time to deliver more work and focus on value-adding tasks. This efficiency 

increases your realization rate and revenue for the firm. For example, if you charge $500 to 

draft a set of documents that would previously take you 8 hours but now only takes 2 hours, 

you’ve increased your hourly billing rate by a huge margin.

Some lawyers report that using automation to generate documents results in time savings of 

up to 83%. This frees lawyers to work on more complex and valuable legal issues and sign 

new clients.

LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com
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“I would literally go through the entire document 
and change everything, and then make sure it 
all corresponded with my notes. The issue with 
doing things manually is that you run the risk of 
slipping up and making a mistake. It doesn’t look 
professional when you make those kind of errors.”

Samuel E. Thomas  |  Law Office of Samuel E. Thomas  |  Athens, GA

Increases profitability

Alternative fee agreements are becoming widely popular within the legal industry. 

Document automation allows firms to take work that traditionally would have been billable-

hour based and turn it into a fee agreement that best suits the project. This will enable firms 

to utilize their time efficiently to make more money and sign new clients. For example, if a 

client wants a lawyer to prepare his will, the firm can have it ready in an hour or less with 

automation, so it makes sense to charge a fixed fee. The fixed cost can be lower for the 

client’s benefit, but the firm can still profit by serving more clients.
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Reduce errors

Enhances client experience

Legal templates are a starting point for creating new legal documents for law firms, so it is 

critical that these remain updated and error-free. When you start each template from scratch, 

you risk inputting data inaccurately or omitting essential details. Plus, there’s always the risk of 

sharing documents with clients without reviewing the complete package. In one survey, 33% of 

legal professionals admitted skipping proofreading when creating or reviewing legal documents.

With automated templates, you can quickly populate data across sets of documents instead 

of updating them one by one. As long as client and matter details are correctly entered into 

the system the first time, your templates will maintain accuracy, eliminating the need for 

proofreading. This saves the firm money and embarrassing mistakes.

It also ensures uniformity across all templates. You may set standards within the firm for creating 

documents for the organization. But you cannot be sure that the guidelines will always be 

followed. Automation maintains consistent branding across all templates, so it’s ready to use for 

new and existing employees.

The speed of project delivery is closely aligned with accuracy. With automated legal documents, 

lawyers can design and share docs tailored to each client’s requirements and specifications. If the 

software uses advanced features like conditional logic, you can easily customize the document 

with a few clicks. This can easily set you apart from your competition while saving both parties 

the time, confusion, and frustration caused by back-and-forth emails.

The actual return is when clients come back with bigger and more profitable matters, and your 

retention and referral rates and firm revenues increase.  

https://www.lexisnexis.co.uk/blog/restructuring-and-insolvency/draft-different-66-of-lawyers-feel-they-are-under-too-much-time-pressure
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Promotes knowledge building
The process of designing high-quality templates usually involves input from the best legal 

experts. Automation enables you to share these with junior staff or new employees so they, 

too, can serve clients with the same level of quality as your senior lawyers. And even if a drafter 

leaves the firm, you will have the internal knowledge to produce the necessary documents. 

Instead of reinventing the wheel every single time, your legal staff can gain access to smart 

automated templates and start generating documents in minutes.  

19
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VII. Top features that make up advanced 
document automation

Conditional logic
Legal documents require modifications beyond the standard details like name, address, 
and date, and that’s where conditional logic comes in. It allows you to add if/then rules and 
conditions, like pronouns, to create reactionary automation. Once you’ve set your rules, it 
will automatically delete or insert text, sentences, and more based on specific case details, 
and populate within all corresponding documents.

LEGAL DOCUMENT AUTOM ATION
&  C LO U D - B A S E D  C O U R T F O R M S www.lawyaw.com
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For example, with Lawyaw’s advanced conditional logic, you can easily update personal 

pronouns (he/she/they) based on client information with conditions that automatically 

populate pronoun variations (him/her/them) throughout documents. You can also reuse the 

rules in other templates.

Form duplication

E-signature

Save you and your team the trouble of recreating new packages for existing clients using 

document duplication. Lawyers often have to create similar documents for one client but 

only change minor details like name and date. For example, a client with four children wants 

to make his will. If you were to do this manually, you would have to build the form four times 

and type out the details of all four children one by one. With automation, you only create 

one copy, duplicate it three more times, and auto-populate their details into the document 

without leaving the drafting workflow. 

In the last few years, there’s been an increase in the number of firms and clients embracing 

electronic signatures. Not only do they simplify and speed up the signing process, they also 

address a pressing need of the pandemic: the ability to collaborate over and sign  

documents remotely. 

When researching a document automation platform, look for an e-signature tool that 

allows for easy sending and tracking. A robust software will automatically update you about 

pending and completed signatures. It will share mobile and web access for a smooth user 

experience, intuitively guiding you and your clients through the document for e-signature. 

Lawyaw comes with built-in e-signature features, which means you can draft your documents 

in the cloud and share directly with teammates and clients for signature.
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Whether you are looking to transform your firm’s existing MS Word 
documents into easy-to-fill, reusable templates, or quickly populate 
client data from our library of official state and USCIS forms,  
Lawyaw can make it happen.

Video Tutorial: Building a Solid 
Foundation in MS Word

Reduce Time Spent on Routine 
Drafting by 80%

You may also be interested in:

Thousands of law firms 
across North America have 
generated a combined 
10 million documents in 
Lawyaw. That’s more than 
833,000 work days’ worth 
of manually cutting and 
pasting in Word docs saved 
by our users.

View Tutorial Discover the solution

https://www.lawyaw.com/templates
https://www.lawyaw.com/templates
https://www.lawyaw.com/webinars/saving-time-with-cloud-based-court-forms
https://www.lawyaw.com/ebooks/the-essential-guide-to-legal-document-automation

